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Abstract. Guidelines for computer analysis of images obtained by scanning zooplankton samples using 
ImageJ / Fiji and ilastik software have been developed. Instructions are given for post-processing of 
the primary pre-scanned material, which includes segmentation of zooplanker images and creating 
collections for subsequent recognition in the Object Classifiction / ilastik module. Creating these 
collections optimizes the work with large high-resolution image files and simplifies constructing a 
classifier. The method proved effective for studying spatial distribution of size structure in the population 
of copepod Arctodiaptomus salinus in Lake Shira. The technique was also tested on samples of natural 
zooplankton from lakes in the northern part of Minusinsk Lowlands (Republic of Khakassia) which 
have different species compositions and abundance of planktonic organisms. The capacity of bioimage 
analysis (BIA) for identification of zooplankton species is limited. However, in combination with 
traditional microscopy, it can be also used for studying the taxonomic structure of zooplankton. Based 
on the research results, the advantages, limitations and implications of BIA methods for processing 
zooplankton samples are discussed.
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Компьютерная обработка и анализ  
сканированных проб зоопланктона:  
методические рекомендации
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Аннотация. Разработаны методические рекомендации для компьютерного анализа получаемых 
в результате сканирования проб зоопланктона изображений с помощью программного обеспечения 
ImageJ/Fiji и ilastik. Приведены инструкции для постобработки первичного отсканированного 
материала, процедур сегментирования и создания коллекций изображений зоопланктеров 
с целью последующего распознавания в модуле Object Classifiction / ilastik. Предлагаемая 
методика оптимизирует работу с большими файлами изображений в высоком разрешении 
благодаря созданию коллекций и упрощает задачу построения классификатора. Методика 
оказалась эффективной для решения задачи изучения пространственного распределения 
размерной структуры популяции копепод Arctodiaptomus salinus в оз. Шира. Кроме того, методика 
тестировалась на пробах естественного зоопланктона озер Северо-Минусинской котловины 
(Республика Хакасия), имеющих разные видовой состав и численность планктонных организмов. 
Возможности видовой идентификации зоопланктеров по сканированным пробам были ограничены, 
однако в сочетании с традиционной микроскопией метод биоимидж-анализа (БИА) также 
позволяет выполнять исследования таксономической структуры зоопланктона. На основе 
результатов тестирования приводится обсуждение преимуществ, ограничений и перспектив 
развития методов БИА для обработки проб зоопланктона.

Ключевые слова: зоопланктон, визуализация (биоимидж-анализ), сканирование, 
микроскопирование, размерная структура, таксономическая структура.
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Введение

Биоимидж-анализ (БИА) является уни-
версальным инструментом для широкого 
спектра биологических дисциплин, позволя-
ющим извлекать количественные показате-
ли из  цифровых изображений исследуемых 
объектов различных уровней организации  – ​
от субклеточного до популяционного (Miura, 
Sladoje, 2020; Rebollo, Bosch, 2019). Цифровой 
материал, обрабатываемый методами БИА, 
может представлять из  себя сложный ком-
плекс данных, от 2D‑изображений, получен-
ных с  помощью фотокамер или планшетно-
го сканера, до  сканирующей конфокальной 
микроскопии (5D‑изображения, включающие 
съемку в  разных спектральных диапазонах 
в  трехмерном пространстве и  с  временным 
разрешением). Уровень качества (разрешения 
снимков) и  сложности (многоканальности) 
получаемого материала постоянно повыша-
ется.

В последние десятилетия для оптимиза-
ции сбора информации в водоеме и обработ-
ки проб морские биологи активно используют 
цифровые технологии, в  частности методы 
визуализации, как in situ, так и  в  лаборато-
рии (обзоры Benfield et al., 2007; Lombard et 
al., 2019). Однако использование дорогосто-
ящей и  высокотехнологичной аппаратуры 
не  всегда доступно исследователям. Многие 
подводные аппараты существуют в  ограни-
ченном количестве и являются уникальными 
разработками отдельных институтов, напри-
мер FIDO-Φ, VPR, LAPIS, ZOOVIS-SC и т. д. 
(Benfield et al., 2007). Примером применения 

метода визуализации in situ служит получе-
ние профиля планктона и взвешенных частиц 
с помощью коммерчески доступного аппара-
та UVP – ​underwater video (vision) profiler (на-
пример, Jouandet et al., 2011). В пресноводных 
экологических исследованиях также начина-
ют применять современные технологии полу-
чения фото- и видеоматериала, включая 3D- 
видеорегистрацию биологических объектов 
in situ (например, Simoncelli et al., 2019).

Альтернативой дорогостоящему обо-
рудованию может быть использование бы-
товых экшн-камер и  планшетных сканеров. 
Полученные с  помощью этих устройств 
цифровые изображения зоопланктона мо-
гут быть обработаны методами БИА и  про-
граммами, использующими алгоритмы ма-
шинного обучения. Этот подход может дать 
эффективные методики для решения про-
блемы рутинной обработки проб зооплан-
ктона. Данный принцип был, например, ре-
ализован в  проекте ZOOSCAN (Grosjean et 
al., 2004), который включал инструмент для 
сканирования проб на  основе сканера про-
фессиональной серии Epson Perfection и про-
граммного обеспечения на  основе ImageJ 
(Abramoff et al., 2004). Проект получил свое 
последующее развитие (например, Gorsky et 
al., 2010; Vandromme et al., 2012) как анали-
тическая платформа PIQv (https://sites.google.
com/view/piqv/home, обращение 03.12.2020), 
являясь частью Imaging platforms EMBRC-
France (https://www.embrc-france.fr/en/nos-
services/plate-formes-technologiques/imagery, 
обращение 03.12.2020). Аналитическая плат-
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форма включает такие компоненты, как про-
граммное обеспечение ZooProcess для об-
работки первичного цифрового материала 
(инструментов ZooScan, FlowCam и  UVP) 
и ECOTAXA для таксономической классифи-
кации. В  основном платформа используется 
для анализа морского планктона.

Для анализа озерных проб зоопланкто-
на мы также применяли связку планшетно-
го сканера Epson Perfection V 850 Pro с про-
граммой imageJ/Fiji, добавив возможности 
ilastik (Berg et al., 2019). Цель работы – ​оце-
нить потенциал методики обработки проб 
с  использованием сканера и  доступного 
программного обеспечения для решения 
различных задач, в  частности для опреде-
ления численно-размерной структуры попу-
ляций зоопланктеров, для цветовой диффе-
ренциации живых и  мертвых особей после 
соответствующей окраски проб прижиз-
ненным красителем, для таксономической 
идентификации организмов по  видимым 
признакам. Реализация этой цели состояла 
в нахождении определенной последователь-
ности фильтров, преобразований и настрой-
ки параметров приложения, оптимальных 
для сегментации и  распознавания организ-
мов зоопланктона по сканированным изобра-
жениям. При этом часть рутинных процедур 
автоматизировалась с  помощью минималь-
ного программного кода в  imageJ/Fiji. Ито-
гом стали представляемые здесь методиче-
ские рекомендации для анализа природных 
проб зоопланктона, в  которых помимо са-
мих зоопланктеров присутствует множество 
объектов сопоставимого размера – ​крупные 
водоросли и детрит. Мы старались избегать 
инструкций, усложняющих либо избыточно 
детерминирующих процесс обработки изо-
бражений. Все это сохраняет свободу моди-
фикаций алгоритма и позволяет не зависеть 
от версий используемых программ.

Материалы и методы,  
методические рекомендации

Весь процесс обработки проб зоопланк
тона методом БИА можно разделить на  три 
этапа. На  первом этапе производится подго-
товка проб для сканирования с  заданными 
параметрами. На втором этапе осуществляет-
ся первичная обработка изображений и созда-
ется коллекция объектов для распознавания 
и измерения. На третьем этапе проводится об-
учение алгоритмам, классифицирующим ин-
тересующие нас объекты. Результатом БИА 
является итоговая таблица с количественны-
ми характеристиками каждого объекта.

Каждый из этапов имеет «узкие» места, 
где неудача способна существенно понизить 
качество или даже сделать невозможным 
обработку сканированных проб методом 
БИА. Прежде всего, необходимо получить 
качественные изображения организмов зоо
планктона, что служит основой дальнейшей 
обработки. Последующая обработка (по-
стобработка) изображений не  сможет суще-
ственным образом исправить дефекты перво-
го этапа, если таковые будут присутствовать. 
Во-вторых, необходимо максимально упро-
стить задачу распознавания объектов для 
программы. Не стоит надеяться на сверхвоз-
можности имеющихся в настоящее время ал-
горитмов обучения и  распознавания объек-
тов. Разнообразие объектов должно быть как 
можно ниже для отдельно обрабатываемого 
изображения. Добиться этого можно двумя 
способами: 1)  предварительное фракциони-
рование проб с помощью сит разного размера 
и 2) компьютерная очистка уже полученных 
изображений и  создание выборочной кол-
лекции интересующих нас объектов. Далее 
приводятся методические рекомендации, по-
зволяющие повысить качество анализа ска-
нированных проб зоопланктона для каждого 
этапа.
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1. Подготовка материала и сканирование

Сканирование проб зоопланктона осу-
ществляли с помощью планшетного сканера 
Epson Perfection V 850 Pro. Для работы с про-
бами использована специально изготовлен-
ная камера, состоящая из  рамки размером 
9х14 см, напечатанной на 3D‑принтере, с при-
клеенным к  ней прозрачным дном из  PPTE 
пластика 0.5  мм. Рамка вставлялась в  дер-
жатель, идущий в  комплекте со  сканером. 
Верхние выступающие края рамки позволя-
ли зафиксировать камеру в держателе таким 
образом, чтобы дно располагалось в  2  мм 
от стекла. Такое положение камеры обеспечи-
вает правильную фокусировку сканера на об-
разце при высоких разрешениях.

Разделение пробы на  размерные фрак-
ции проводили с помощью полиамидных сит 
с размером ячеи 120 и 400 мкм. Через мелкое 
сито промывали пробы от  фиксатора (фор-
малина либо спирта). Эта процедура также 
способствовала удалению мелких мусорных 
частиц <120 мкм, накапливающихся в  хра-
нящихся пробах. С  помощью крупного сита 
промытую пробу делили на  две размерные 
фракции (менее 400 мкм и более 400 мкм) для 
последующего сканирования.

Заполнение камеры и  отделение орга-
низмов друг от друга проводили по методике 
для работы с ZooScan (Picheral, Elineau, 2020). 
Чтобы избежать появления пузырьков в  ка-
мере, проба разбавлялась кипяченой водой, 
остуженной до 60  °C. Разделение скоплений 
организмов и  отделение их от  границ каме-
ры проводили с  помощью мягкой препаро-
вальной иглы, не  экономя время, поскольку 
от тщательности разделения особей и их рас-
положения зависит качество обработки изо-
бражений.

Настройки параметров сканера были 
следующие: сканирование с  верхним осве-
щением, прозрачный образец с  держателем, 

цветное изображение с  разрешением 6400 
DPI. Область сканирования задавали для всей 
камеры с незначительным (1–2 мм) захватом 
границ рамки.

2. Постобработка первичных изображений

Постобработка полученных первич-
ных изображений сканированных проб зоо
планктона была выполнена в  программах 
IrfanView‑64 и  ImageJ/Fiji‑64. Постобработка 
заключалась в уменьшении исходного разме-
ра сканов, сглаживании шумов и вычитании 
фона. Работа с  первичными изображениями 
показала, что сканирование с  разрешением 
более 6400 DPI почти не  улучшает качество 
БИА, но  критическим образом увеличивает 
время обработки изображений и  повыша-
ет требования к  памяти и  вычислительным 
мощностям компьютера. Для обработки изо-
бражений методом БИА желательно исполь-
зовать производительные компьютеры с объ-
емом памяти 16 Гб и процессором уровня Intel 
core-i7. Тем не менее первичное сканирование 
проб все же важно проводить при 6400 и бо-
лее DPI. Позднее при необходимости можно 
понизить разрешение на стадии постобработ-
ки, что даст более качественное изображение 
объектов, чем сканирование с  низким DPI. 
Более того, изображения с высоким разреше-
нием могут быть обработаны повторно на бо-
лее мощных ПК.

Постобработку первичных изображе-
ний проводили с использованием программы 
IrfanView. В  ней проводили уменьшение ис-
ходного размера скана в два раза и удаление 
темных полей рамки вокруг открытого поля 
камеры. Однако если производительность 
компьютера позволяет, то все операции мож-
но осуществлять только в ImageJ/Fiji. В про-
грамме ImageJ/Fiji проводили понижение 
уровня шума путем применения фильтра 
Median с параметром Radius = 1 пиксель. Этот 
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фильтр позволяет уменьшить шум, сохраняя 
резкость контуров, что важно для примене-
ния процедуры сегментирования на  более 
поздних этапах обработки. После этого уби-
рали серый фон изображения простым вы-
читанием порогового значения. Ниже дана 
подробная инструкция постобработки изо-
бражений.

2.1. Запускаем программу «IrfanView».
2.2. Открываем изображение из програм-

мы «IrfanView».
2.3. Выделяем область, которую необхо-

димо обрезать, затем: Edit > Crop selection.
2.4. Уменьшаем изображение в два раза: 

Image > Resize/Resample > Half (рис. 1a).
2.5. Сохраняем файл.
2.6. Открываем файл в программе ImageJ/

Fiji.
2.7. Инвертируем изображение: Edit > 

Invert.
2.8. Убираем шум: Process > Filters > 

Median; в новом окне ставим 1 (рис. 1b).
2.9. Далее находим нужный нам объект 

и  проводим линию инструментом «Straight 
Line», чтобы она пересекала его (рис. 1с).

2.10. Analyze > Plot Profile показывает 
следующую картину (рис. 1d). Пик, который 
мы видим,  – ​это наш объект, все остальное, 
от  нуля и  примерно до  10 по  шкале «Gray 
Value»,  – ​это шум, от  которого необходимо 
избавиться следующим образом.

2.11. Process > Math > Subtract (рис.  2а): 
в новом окне ставим цифру 10, верхний порог 
шума.

2.12. Сохраняем данное изображение под 
новым именем – ​оно понадобится позже для 
построения коллекции объектов.

Следующим шагом обработки было соз-
дание грубой маски объектов в виде 8-битно-
го изображения в ImageJ/Fiji. Маску создава-
ли, переводя изображение в градации серого, 
после чего применялась функция Threshold 

из меню Image > Adjust. Лучшие результаты 
показывали алгоритмы Otsu и  RenyiEntropy. 
Пороговое значение подбирали таким обра-
зом, чтобы маска полностью охватывала изо-
бражения зоопланктеров с небольшой частью 
фона (over-segmentation). При необходимости 
применяли функцию Process > Binary > Fill 
Holes. Более точную настройку сегментации 
выполняли позже в ilastik. На основе получен-
ной маски находили контуры объектов и со-
храняли их в ROI‑менеджере. На этом же шаге 
проводили отсеивание ненужных объектов, 
устанавливая минимальные и максимальные 
значения параметров площади и скругленно-
сти объектов, используя параметры функции 
Analyze Particles и из вкладки меню Analyze. 
Ниже дана пошаговая инструкция создания 
грубой маски объектов.

2.13. Полученное в  результате преды-
дущих операций изображение переводим 
из цветного в 8-битное: Image > Type > 8-bit.

2.14. Image > Adjust > Threshold: в  от-
крывшемся окне в  параметрах выбираем 
наиболее подходящий способ сегментации, 
выставляем опцию Dark background и форму 
выдачи «B&W» (рис. 2b).

2.15. После данной команды в  видимых 
параметрах изображения может появиться 
дополнительная надпись «Inverting LUT». 
Избавляемся от нее: Image > Lookup Tables > 
Invert LUT.

2.16. Следующий шаг  – ​добавляем все 
объекты в  ROI Manager: Analyze > Analyze 
Particles (рис. 2c).

2.17. На изображении все объекты будут 
обведены цветным контуром. Выделив мыш-
кой отдельный объект, получим соответ-
ствующее выделение строки в  ROI Manager 
(рис. 3а).

2.18. После нажатия кнопки Measure 
можно узнать некоторые морфологические 
параметры выделенной фигуры. Список рас-
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Рис. 1. Иллюстрация пунктов 2.4 (a), 2.8 (b), 2.9 (c), 2.10 (d)

Fig. 1. Illustration for items 2.4 (a), 2.8 (b), 2.9 (c), 2.10 (d)
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Рис. 2 Иллюстрация пунктов 2.11 (a), 2.14 (b), 2.16 (c)

Fig. 2. Illustration for items 2.11 (a), 2.14 (b), 2.16 (c)

считываемых параметров задается на вклад-
ке Analyze > Set Measurements…

2.19. Далее необходимо провести пер-
вичное удаление ненужных объектов из ROI 
Manager  – ​мелких частиц, царапины и  т. д. 
Для этого повторяем команду Analyze > 
Analyze Particles, установив интервал границ 
площади (Size) и  скругленности (Circularity) 
интересующих нас объектов. Чтобы опре-
делиться с  интервалами, смотрим площадь 
и  скругленность объектов, следуя пун-
ктам 2.17 и 2.18 инструкции. Если разделение 
объектов в пробе не удалось на этапе скани-
рования, то  рекомендуется создать отдель-
ную коллекцию для скоплений объектов, за-
дав для них размерный порог немного выше 

самого крупного единичного объекта. Такую 
коллекцию можно обработать в ручном режи-
ме с помощью ImageJ/Fiji. К сожалению, эф-
фективные алгоритмы автоматического раз-
деления скоплений зоопланктеров авторам 
статьи на сегодняшний день не известны.

2.20. ROI Manager оставляем открытым, 
а черно-белое изображение закрываем – ​оно 
больше не  понадобится. Открываем ранее 
сохраненное цветное инвертированное изо-
бражение и отображаем на нем контуры всех 
объектов из ROI Manager.

2.21. В  ROI Manager выделяем все объ-
екты (Ctrl + A) и создаем из них комбиниро-
ванное выделение с помощью ROI Manager > 
More > OR (Combine). Затем выполняем Edit 
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Рис. 3. Иллюстрация пунктов 2.17 (a), 3.1 (b)

Fig. 3. Illustration for items 2.17 (a), 3.1 (b)

> Clear Outside – ​эта процедура очистит фон 
рабочего изображения.

2.22. Сохраняем очищенное рабочее изо-
бражение (цветное инвертированное) и сохра-
няем объекты в ROI Manager: More > Save…

3. Создание коллекции объектов

Создание коллекции завершает этап под-
готовки изображений для распознавания, 
классификации и получения итоговых харак-
теристик организмов зоопланктона в  пробах 
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(морфометрические параметры, оптическая 
плотность тканей, цвет и  т. д.). Коллекция 
представляет из  себя компактное размеще-
ние объектов в отдельном графическом файле 
в  виде сетки. Коллекция упрощает дальней-
ший процесс обработки изображений тем, что, 
во‑первых, уменьшает количество объектов 
на входе программы распознавания (часть объ-
ектов отфильтровывается на основании пара-
метров площади и скругленности), а во‑вторых, 
дает сжатое и  упорядоченное расположение 
объектов, способствующее их быстрой класси-
фикации оператором на стадии обучения про-
граммы. При необходимости файл коллекции, 
если он занимает большой объем, может быть 
разделен на коллекции меньших размеров без 
потери объектов на линиях разреза. Создание 
коллекции происходит в два этапа. Суть пер-
вого этапа состоит в том, что каждый объект 
вырезается из исходного сканированного изо-
бражения и  сохраняется как отдельный файл 
во временную директорию. Данная процедура 
реализуется с  помощью кода, создаваемого 
с  помощью встроенного редактора в  ImageJ/
Fiji (File > New > Script…). Нами представлен 
3.1 – ​скриншот окна редактора (рис. 3b) и не-
которые пояснения к коду.

SetBatchMode(true)  – ​переводит процесс 
обработки изображений в  фоновый режим, 
чтобы не  выводить на  экран все действия 
и минимизировать нагрузку на систему;

run(«Duplicate…», «title = crop») – ​созда-
ние копии исходного изображения;

roiManager(«Select», u)  – ​выделение оче-
редного объекта в цикле;

run(«Crop»)  – ​изображение обрезается 
по размеру выделенного объекта;

saveAs(«Tiff»,»E:/projects/scan-paper/
output/» + «The_Particle_» + (u+1) + «.tif») – ​со-
хранение объекта в указанную директорию;

close() – ​закрытие текущего изображения 
объекта.

Суть второй части состоит в том, чтобы 
компактно разместить все вырезанные объек-
ты на одном изображении. Ниже представлен 
3.2  – ​код второго этапа создания коллекции 
(рис. 4а) и пояснения к нему.

List = getFileList(«E:/projects/scan-paper/
output/») – ​создание списка файлов в указан-
ной директории;

open(«E:/projects/scan-paper/output/» + 
list[i]) – ​открытие изображения;

run(«Images to Stack», «method=[Copy 
(center)] name=Stack title=[] use»);

run(«Make Montage…») – ​сборка всех изо-
бражений в одно;

run(«Invert»)  – ​инвертирование изобра-
жения.

Также выделяем необходимую часть, вы-
полняем 3.3: Run > Run selected code и получа-
ем коллекцию объектов (рис. 4b). Сохраняем 
и приступаем к дальнейшей обработке.

4. Классификация объектов  
в приложении ilastik

Важнейшей частью компьютерной об-
работки изображений является сегментация 
объектов, т. е. отделение их от фона. От пра-
вильного определения границ объектов зави-
сит точность снимаемых морфометрических 
характеристик и  качество работы будущего 
классификатора. Первичная сегментация 
зоопланктеров была выполнена в  ImageJ/Fiji 
на  предыдущем этапе. Дальнейшая работа 
выполняется в  программе ilastik. На  теку-
щем этапе мы уточняем границы объектов 
относительно фона, используя модуль Pixel 
Classification, и  производим разделение объ-
ектов на классы в модуле Object Classification. 
Работа с  каждым модулем осуществляется 
независимо. Однако сохраненные результаты 
обработки изображений, полученные в  Pixel 
Classification, становятся входящими пара-
метрами для Object Classification и  должны 
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Рис. 4. Иллюстрация пунктов 3.2 (a), 3.3 (b), 4.3 (c)

Fig. 4. Illustration for items 3.2 (a), 3.3 (b), 4.3 (c)
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быть импортированы в  начале работы. Вну-
три модулей процесс обработки изображений 
организован в виде пошаговых действий. На-
стройки каждой процедуры собраны в аппле-
ты, которые становятся доступными по мере 
выполнения анализа.

Модуль Pixel Classification позволяет 
создавать карту прогнозирования (prediction 
map), в которой каждому пикселю присваива-
ется вероятность его принадлежности к опре-
деленному классу элементов изображения. 
На  данном шаге мы рекомендуем создавать 
только два класса: первый класс будет вклю-
чать все объекты коллекции, а  ко  второму 
классу будет относиться фон. Разделение пик-
селей на классы происходит путем обучения 
нейросети модуля. Данный процесс реали-
зован в виде «раскраски» участков объектов 
и фона с помощью инструмента кисть. Карта 
прогнозирования создается в интерактивном 
режиме и сразу отображается в окне вывода, 
что позволяет контролировать процесс и кор-
ректировать результаты при необходимости. 
Создание карты – ​многоступенчатый процесс, 
требующий настройки и подбора параметров 
фильтров (Feature Selection) для анализа. Од-
нако шаблон карты может быть в дальнейшем 
перенесен на  другие изображения сходных 
объектов. Выполняя классификацию пиксе-
лей, необходимо обращать внимание толь-
ко на  результаты обработки интересующих 
видов зоопланктеров, поскольку качество 
сегментации других объектов не  важно для 
дальнейшего анализа. Карта прогнозирова-
ния сохраняется в формате.h5.

Подробные инструкции по  работе 
с  Pixel Classification и  другими модуля-
ми можно найти в  разделе помощи сайта 
ilastik (https://www.ilastik.org/documentation/
pixelClassification/pixelClassification) и некото-
рых мастер- классах, доступных на YouTube 
(Kreshuk, Kutra, 2020). Ниже дана последо-

вательность действий при работе с  модулем 
Pixel Classification.

4.1. Запускаем ilastik и добавляем изобра-
жение (созданную коллекцию) для анализа: 
Pixel Classification > Raw data > Add new…

4.2. Выбираем фильтры: Feature selection 
> Select Features. Фильтры могут подбираться 
индивидуально в зависимости от типа объек-
тов. Мы использовали σ0=0.3 до σ1=0.7.

4.3. Открываем графу «Training». Здесь 
необходимо «обучить» программу распозна-
вать фон и  объекты, примерно как показано 
на  рис.  4c. Заданные по  умолчанию клас-
сы объектов находятся слева под названия-
ми «Label 1» и  «Label 2» (можно присвоить 
им другие имена). Выбираем первый класс 
и с помощью инструмента «кисть» отмечаем 
на  рисунке некоторое количество объектов, 
которые собираемся считать (коловратки, ко-
пеподы, кладоцеры). Выбираем второй класс 
и  отмечаем участки, являющиеся фоном: 
непосредственно белый фон и  ореол серых 
пикселей вокруг объектов, если он присут-
ствует. Кнопка «Live Update» позволяет уви-
деть промежуточный результат прогнозиро-
вания, и если программа обозначила нужный 
объект как фон, то на данном этапе можно это 
исправить, воспользовавшись инструментом 
«ластик».

4.4. Переходим к  следующей вкладке 
и  запускаем Suggest Features > Run Feature 
Selection. Данный процесс займёт некоторое 
время, так как из  множества комбинаций 
применения фильтров программа подбирает 
наиболее подходящие. Затем следует выбрать 
из появившегося списка тот набор фильтров, 
который лучше всего подходит для сегмента-
ции, и нажать на кнопку «Select Feature set». 
Последовательность действий обозначена 
на рис. 5a цифрами 1, 2 и 3.

4.5. Сохраняем: Prediction Export > Source: 
Probabilities > Export All. Сохраняем сам про-
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Рис. 5. Иллюстрация пунктов 4.4 (a), 4.7 (b), 4.8 (c)

Fig. 5. Illustration for items 4.4 (a), 4.7 (b), 4.8 (c)

ект, чтобы в  дальнейшем была возможность 
им воспользоваться: Project > Save Project.

4.6. Существует возможность приме-
нения карты прогнозирования на  несколько 
изображений: Batch Processing > Raw data > 
Select Raw Data Files, затем нажать кнопку 
Process all files. Таким образом, мы получим 
«prediction map» для каждого изображения.

С  помощью модуля Object Classification 
производится построение классификатора 
и  разделение объектов на  классы на  основе 
морфологических характеристик и статисти-
ческих параметров интенсивности пикселей. 
Вначале карта прогнозирования, созданная 

в  модуле Pixel Classification, преобразуется 
в  обычную бинарную маску путем выбора 
порогового значения. На основе бинарной ма-
ски происходит сегментация объектов исход-
ного изображения. Обучение классификатора 
осуществляется путем клика мышкой на объ-
екты одного класса, которые окрашиваются 
в одинаковый цвет. Затем нужно выбрать сле-
дующий класс объектов, задать для него цвет 
и  снова отметить несколько соответствую-
щих объектов на скане. Программа сразу пы-
тается предсказать принадлежность каждого 
объекта коллекции тому или иному классу, 
закрашивая их разными цветами. Наглядная 
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визуализация процесса позволяет достаточно 
быстро настроить классификатор. Результаты 
классификации могут быть экспортированы 
как в  виде графических изображений, так 
и в табличных форматах, включая.csv, для по-
следующего анализа. Таблица экспорта фор-
мируется пользователем и  может содержать 
все измеренные параметры объектов. Модуль 
Object Classification имеет множество аппле-
тов для различных преобразований изобра-
жений, настройки фильтров и вывода проме-
жуточных результатов обработки. Он также 
имеет инструменты для работы с большими 
файлами и  позволяет осуществлять анализ 
в  пакетном режиме. Подробное описание 
процесса обучения классификатора в модуле 
Object Classification изложено далее.

4.7. Запускаем ilastik. Из  предостав-
ленного списка выбираем модуль «Object 
Classification». Вначале загружаем исходное 
изображение: Raw data > Add new. Затем за-
гружаем карту прогнозирования этого изо-
бражения, которую мы получили на  пре-
дыдущем этапе: Prediction Maps > Add new. 
Результат наложения карты прогнозирования 
на изображение можно увидеть на рис. 5b, где 
красным цветом обозначены объекты.

4.8. Открываем второй раздел «Threshold 
and Size Filter». Здесь необходимо задать по-
рог сегментирования, после применения ко-
торого все объекты раскрасятся различными 
цветами. Порог подбирается таким образом, 
чтобы конур объектов был максимально точ-
но подогнан к  их реальной границе. Здесь 
также можно задать интервал размеров объ-
ектов для последующего анализа. Объек-
ты, не  попадающие в  заданный диапазон, 
не окрашиваются и не участвуют в дальней-
шей обработке. После изменения параметров 
необходимо нажать кнопку «Apply» чтобы 
отобразить полученный результат, примерно 
такой, как на рис. 5c.

4.9. Далее выбираем фильтры для клас-
сификации: Object Feature Selection > Select 
Features > All excl. Location. Затем так-
же можно убрать галочки со  всех пунктов 
«neighborhood», как показано на  рис.  6a, по-
скольку нет необходимости выбирать филь-
тры, связанные с  окружающими объектами. 
Объекты уже были отдалены друг от  друга 
в процессе создания коллекции.

4.10. Следующий этап  – ​построение 
классификатора. Открываем раздел «Object 
Classification», в  апплете с  названием «Label 
Classes» создаем необходимое количество 
классов с помощью кнопки «Add Label» и даем 
классам свои названия. Названия классов бу-
дут присвоены каждому объекту в  итоговой 
таблице. Далее, с  помощью кисти выделяем 
несколько объектов в  каждом классе. Кноп-
ка «Live Update» показывает промежуточные 
результаты прогнозирования, за  которыми 
необходимо следить и исправлять возможные 
ошибки идентификации объектов. В  нашем 
примере, представленном на  рис.  6b, синим 
цветом выделены скопления зеленой водорос-
ли Botryococcus, желтым – ​науплиусы и копе-
подитные стадии Arctodiaptomus salinus, а ро-
зовым – ​коловратки Brachionus plicatilis.

4.11. Когда результаты классификации 
покажутся удовлетворительными, выполня-
ем их сохранение: Object Information Export 
> Configure Feature Export. В  окне с  параме-
трами сохранения меняем формат с HDF (.h5) 
на  CSV (.csv), чтобы таблицу результатов 
можно было открыть в  каком-либо таблич-
ном редакторе, например в  Excel. Выбираем 
все параметры: Features > All > Export All.

4.12. Итоговую таблицу импортируем 
в Excel (или в другое приложение для работы 
с таблицами), указывая запятую как раздели-
тель столбцов. Используя полученные дан-
ные, можно проводить дальнейшие расчеты 
и статистический анализ.
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5. Пробы озерного зоопланктона,  
использованные в биоимидж-анализе

Для проверки эффективности нахожде-
ния по  вышеописанной методике размерно-
количественных характеристик популяций 
зоопланктона использовали пробы зооплан-
ктона из  оз. Шира. Пробы были собраны 

с  целью изучения пространственного рас-
пределения популяции доминирующего вида 
копепод Arctodiaptomus salinus. Зоопланктон 
ловили однократно замыкающейся сетью 
Джеди (диаметр входного отверстия 20  см, 
ячея капронового сита 82 мкм) с  горизонтов 
0–1, 1–3, 3–5 и  5–12  м на  6 равноудаленных 

Рис. 6. Иллюстрация пунктов 4.9 (a), 4.10 (b)

Fig. 6. Illustration for items 4.9 (a), 4.10 (b)
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станциях вдоль центральной трансекты по-
следовательно от  юго-западного (наветрен-
ного) к  северо-восточному (подветренному) 
берегу озера. В анализе использовалась фрак-
ция копепод размером > 400 мкм, поскольку 
согласно ранее проведенным исследованиям 
(Zadereev et al., 2012) в  основном крупные 
особи участвуют в  вертикальных миграци-
ях и могут формировать сложную простран-
ственную структуру.

Возможности метода БИА для диффе-
ренциации живых и  мертвых особей на  ос-
нове применения прижизненных красителей 
также оценены на копеподах A. salinus озера 
Шира. Сетные пробы зоопланктона сразу по-
сле отбора окрашивали анилиновым голубым 
(Gladyshev et al., 2003; Дубовская, 2008), затем 
фиксировали формалином до  окончательной 
концентрации 10 % и хранили до сканирова-
ния в холодильнике.

Для оценки возможностей применения 
вышеизложенного подхода к  таксономиче-
ской идентификации зоопланктона было 
проведено сканирование и осуществлен био-
имидж анализ проб зоопланктона из  озер, 
расположенных на  территории Республики 
Хакасия. Это большие и малые озера в преде-
лах Чебаково-Балахтинской впадины: Джи-
римское, Сухое, Красненькие (3), Белё (Боль-
шое и  Малое), Тус, Слабительное, Киприно, 
Фыркал, Шира, Иткуль, Утичьи (Первое 
и  Третье), Власьево, Шунет, Матарак, Чала-
сколь и Учум. Карту озер и их характеристи-
ку можно найти в работе (Zadereev et al., 2021). 
Эти озера существенно различаются по  со-
лености, морфометрии, гидрологии, уровню 
трофности и,  соответственно, видовому со-
ставу зоопланктона. Весь столб воды или эпи- 
и метагиполимнион в центральной части озер 
облавливали вышеописанной сетью Джеди. 
Все пробы фиксировались формалином в фи-
нальной концентрации 4 %.

6. Определение размерной структуры  
и таксономической принадлежности  
зоопланктона

Размеры тела зоопланктеров на сканиро-
ванных изображениях определяли на  основе 
значений, полученных в процессе проведения 
БИА. Все морфологические характеристики 
объектов экспортируются в виде таблицы ре-
зультатов, доступной для дальнейшего ана-
лиза. В качестве размера тела зоопланктеров 
можно использовать выдаваемый програм-
мой диаметр объектов (Diameter), однако он 
не всегда может напрямую отражать общепри-
нятую величину. Во-первых, за длину тела ра-
кообразных принимается расстояние между 
определенными точками экзоскелета, кото-
рые не  обязательно соответствуют внешним 
контурам объекта. Более того, может суще-
ствовать несколько способов измерений. На-
пример, у  копепод некоторые исследователи 
измеряют длину просомы (например, Jansen, 
2008; Rahlff et al., 2018) или  же измеряется 
общая длина просомы и  уросомы  – ​от  вер-
шины цефалоторокса до  нижней границы 
каудальных ветвей, без каудальных щетинок 
(обзор измерений зоопланктеров дан, напри-
мер, О. Н. Кононовой и Е. Б. Фефиловой (2018). 
У кладоцер каудальный шип также не вклю-
чается в  длину тела (Bledzki, Rybak, 2016). 
Во-вторых, на  сканированных изображениях 
тонкие анатомические структуры зоопланкте-
ров могут быть размыты и  частично терять-
ся в  процессе сегментации. Следовательно, 
корректное определение длины тела очень 
зависит от  выбранных настроек процедуры 
отделения образов зоопланктеров от  фона. 
Поэтому важно не менять порог сегментации 
между изображениями в  одной серии проб, 
а  для определения длины тела желательно 
использовать соответствующую калибров-
ку между измеряемой вручную длиной тела 
(по  сканированному изображению в  ImageJ/
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Fiji с помощью инструмента «линия») и наи-
более подходящим морфологическим пара-
метром из  таблицы результатов (например, 
диаметром объекта). В настоящей работе для 
определения размера A. salinus калибровку 
получали в  виде линейной регрессии на  ос-
нове промера 200 копепод старших возраст-
ных стадий. Диаметр и длина тела считалась 
в пикселях, которые затем переводили в мм, 
используя коэффициент 25.4/DPI, где DPI  – ​
разрешение сканированного изображения.

Определения таксонов зоопланктона 
по  сканированным изображениям методом 
БИА сравнивали с  результатами традицион-
ного микроскопирования особей из  одних 
и тех же проб. Использовали световые микро-
скопы PZO (Warszawa, Poland) и Axioskop 40 
(Carl Zeiss, Германия) с объективами до х40, 
окулярами х10.

Результаты и их обсуждение
Калибровка размеров тела  
и анализ пространственного распределения 
размерной структуры Arctodiaptomus salinus  
в оз. Шира, дифференциация живых  
и мертвых особей

Размерную структуру копепод определя-
ли на  основе линейной регрессионной моде-
ли, связывающей длину тела и диаметр соот-
ветствующего объекта из  итоговой таблицы 
результатов программы ilastik. Границы из-
мерений, уравнение регрессии и R2 приведе-
ны на рис. 7a. Сравнительно большой разброс 
точек (R2 = 0.64) данного примера обусловлен 
не  слишком высоким качеством исходных 
сканированных изображений, которые были 
получены еще на стадии отработки методики 
сканирования. С другой стороны, увеличение 
числа измерений до  нескольких сотен или 

Рис. 7. Линейная регрессия, связывающая размеры тела копепод, измеренные вручную на сканированных 
изображениях (Lman) и размеры этих же рачков (Lcomp), полученные с помощью компьютерной программы 
ilastik (диаметр) (а). Пример рачка, показывающий изменение размера уросомы после применения 
процедуры сегментирования за счет частичного захвата каудальных щетинок (b)

Fig. 7. A linear regression for manual measurements of copepod body size on scanned images (Lman) and 
computer measurements (Lcomp) of the same copepods obtained using ilastik (diameter) (a). An example of a 
copepod demonstrating a change in the urosoma size due to partial capture of the caudal setae after applying the 
segmentation procedure (b)
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тысяч объектов позволяет добиться репре-
зентативности данных для каждой размерной 
группы. Видно, что длина тела одного из рач-
ков, измеренных вручную, отличается в боль-
шую сторону приблизительно на  10 %. Это 
связано с тем, что установить точную грани-
цу сегментирования между уросомой и  ка-
удальными щетинками (caudal ramus) невоз-
можно и,  следовательно, тонкие структуры 
могут появляться или исчезать в  результате 

сегментирования (рис. 7b), что искусственно 
меняет длину тела. Вместе с тем, построение 
калибровочного графика решает данную про-
блему.

Результат обработки проб при изучении 
гетерогенности пространственного распре-
деления популяции Arctodiaptomus salinus 
в оз. Шира представлен на рис. 8. Мы видим, 
что в  17–19 ч 21.06.2019 происходило значи-
тельное увеличение численности рачков в по-

Рис.  8. Гетерогенность пространственной структуры численности и  размера старших копеподитных 
стадий и половозрелых Arctodiaptomus salinus в оз. Шира вдоль трансекты от подветренного (северо-
восточного) к наветренному (юго-западному) берегу во второй половине дня 21.06.2019. Пунктирными 
блоками показано горизонтальное разделение максимумов численности копепод в поверхностном слое 
0–1, 1–3 м (частично) и более глубоких слоях от 1–3 до 5–12 м

Fig. 8. Heterogeneity of the spatial structure of abundance and size of older copepodite stages and mature 
Arctodiaptomus salinus in Lake Shira along the transect from the leeward (northeastern) to the windward 
(southwestern) coast on the afternoon of 21.06.2019. Dotted blocks show the horizontal division of maximum 
copepod abundance in the surface layer 0–1, 1–3 m (partially) and deeper layers from 1–3 to 5–12 m
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верхностном слое (0–1 м) у северо-восточного 
(подветренного) берега до 10.0–15.5 тыс. экз/м3 
против 4.7–6.5  тыс. экз/м3 у  юго-западного 
(наветренного) берега. По размерной структу-
ре (полученной в  результате обработки всей 
пробы, а не только квоты до 100 особей доми-
нирующих видов) можно также заметить, что 
у  северо-восточного берега в  слое 0–1 м на-
блюдалось скопление более крупных рачков 
размером 0.8–1.3  мм, чем у  юго-восточного 
берега  – ​0.5–1.0  мм. Полагаем, такое разде-
ление было вызвано суточной миграционной 
активностью крупных особей, которые в ве-
чернее время (после 18 ч) поднимались к по-
верхности и  за  счет ветровых течений были 

отнесены к  северо-восточному берегу. Слу-
чаи подобных вечерних подъемов зооплан-
ктеров известны (например, Гладышев, 1990; 
Armengol, Miracle, 2000).

Метод БИА оказался перспективным так-
же для задач, связанных с применением кра-
сителей, например для дифференцирования 
зоопланктеров на  живых и  мертвых особей. 
Живые и  мертвые (окрашенные синим цве-
том) не  вызывают трудностей для распозна-
вания с помощью модуля Object Classification 
(рис.  9). Что касается частично окрашенных 
особей, то при определении их статуса следу-
ет руководствоваться рекомендациями (Ду-
бовская, 2008): особей, у  которых окрашено 

Рис. 9. Дифференциация живых и мертвых особей A. salinus с помощью окраски анилиновым голубым 
по  (Gladyshev et al., 2003; Дубовская, 2008). Левая панель  – ​первичное сканированное изображение, 
правая  – ​распознавание живых и  мертвых особей с  помощью построенного классификатора в  ilastik, 
классы объектов выделены голубым (мертвые) и розовым (живые) цветом

Fig. 9. Differentiation of living and dead individuals of A. salinus using aniline blue staining according to 
(Gladyshev et al., 2003; Dubovskaya, 2008). The left panel is a primary scanned image; the right panel is a 
recognition of living and dead individuals using the constructed classifier in ilastik; object classes are colored 
blue (dead) and pink (live)
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≥ 2/3 тела, следует относить к мертвым, менее 
2/3 – ​к живым.

Возможности изучения таксономической 
структуры зоопланктона в рамках метода 
биологического имидж-анализа

Определение видовой принадлежности 
организмов является неотъемлемой частью 
обработки зоопланктонных проб. Однако 
в  рамках метода БИА, очевидно, невозмож-
но идентифицировать организмы формально 
до  вида, поскольку некоторые таксономиче-
ские признаки нельзя увидеть на сканирован-
ных пробах из-за недостаточного разрешения 
сканера. Например, виды могут идентифици-
роваться по вооружению грудной конечности 
первой пары  – ​Moina mongolica, или по  рас-
положению латеральной головной поры  – ​
Bosmina longirostris (Определитель…, 2010). 
Чтобы изучить данные морфологические 
признаки, необходимо провести микроскопи-
рование с разрешением 200–400х. Более того, 
положение тела зоопланктера, при котором 
идет сканирование, не всегда позволяет уви-
деть необходимые признаки или же какая-то 
часть тела может находиться вне фокуса. Тем 
не менее названные ограничения не отменя-
ют целиком возможность таксономического 
анализа. Во-первых, видовой состав зооплан-
ктона может быть заранее известен, напри-
мер, для модельных водоемов с многолетней 
историей наблюдений, либо известна встре-
чаемость видов в определенном регионе, т. е. 
таксономический состав будет потенциально 
ограничен. Следовательно, отдельные виды 
зоопланктеров могут быть «узнаваемы» без 
процедуры дополнительного микроскопи-
рования. Например, доминирующий вид ко-
пепод Arctodiaptomus salinus в таких хорошо 
изученных озерах, как Шира и Шунет, не тре-
бует ежегодной видовой идентификации, по-
скольку крайне маловероятно, что данный вид 

внезапно сменится каким-то другим видом 
калянид, также обитающим в  солоноватой 
воде. Во-вторых, некоторые особи могут быть 
определены до  вида по  БИА, например вид 
Daphnia magna, благодаря крупному разме-
ру, форме постабдомена и головы. На уровне 
семейств и часто родов кладоцеры легко раз-
деляются при разрешении сканера 6400 DPI. 
Основные признаки для идентификации при-
ведены на рис. 10. До рода и иногда даже вида 
определяются с  помощью БИА коловратки. 
В‑третьих, таксономический состав пресно-
водного зоопланктона по  сравнению с  мор-
ским в принципе ограничен всего лишь тремя 
крупными таксонами – ​копеподы, кладоцеры 
и  коловратки. Например, в  оз. Матарак так-
сономический список зоопланктона по  ана-
лизу сканированных проб включал кладо-
цер Bosmina sp., Ceriodaphnia sp., Daphnia 
гр. longispina, Diaphanasoma sp., копепод 
Calanoida, Cyclopoida, других Copepoda, на-
уплий Copepoda и коловраток Asplanchna sp., 
Bipalpus hudsoni (Imhof), Keratella sp., других 
Rotifera. В  оз. Учум результатом БИА был 
список: 1) науплии, копеподиты и половозре-
лые Diaptomidae, 2) Moina sp., 3) Brachionus sp. 
Микроскопирование позволило уточнить: 
1) Arctodiaptomus salinus, 2) Moina mongolica, 
3)  Brachionus plicatilis. Таблица с  полным 
списком видов из 20 озер дана в приложении 
к статье на сайте журнала. Суммарное время 
обработки пробы от подготовки к сканирова-
нию до получения итоговой таблицы с вида-
ми занимало 1,2–1,5 ч.

Перспективы автоматической  
обработки проб

Несомненно, автоматизация обработки 
проб сообществ планктонных организмов 
позволила  бы выйти на  принципиально но-
вый уровень понимания функционирования 
водных экосистем. Более подробная инфор-
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мация о  составе и  численности биоты, ее 
распределении в  пространстве и  времени 
могла  бы решить множество практических 
и  теоретических проблем, где требуется об-
ширный учет присутствующих в  воде орга-
низмов: запас биологических ресурсов, встре-
чаемость редких видов, сукцессия сообществ, 
вопросы фенологии, трофическая сеть, про-
странственное распределение и его динамика 
и т. д. Развитие цифровой фото- и видеотех-
ники, развитие методов компьютерной об-
работки данных в  конечном итоге приведут 
к  желаемому уровню обработки планктона, 
однако в  настоящий момент проблема еще 
далека от  решения. Существующие инстру-
менты уже позволяют дифференцировать ор-
ганизмы зоопланктона на основные таксоно-
мические группы (крупные таксоны) и  даже 
семейства и рода и определять их размерный 
состав (например, Benedetti et al., 2019, на-
стоящая работа). Однако дальнейший шаг, 

который мог бы быть сделан, – ​это распозна-
вание организмов на уровне отдельных видов. 
Очевидно, он потребует высококачественных 
3D‑изображений для последующего анализа. 
Позволяет  ли достигнутый уровень техни-
ческого прогресса на  сегодняшний день по-
строить такую систему счета и  распознава-
ния планктонных организмов? Скорее да, чем 
нет. По  отдельности компоненты такого ин-
струмента уже существуют  – ​сканирующая 
микроскопия, проточная система (Detmer et 
al., 2019), алгоритмы распознавания объектов 
и даже есть проекты базы имиджей биологи-
ческих видов (краткий обзор – ​Lombard et al., 
2019). Основная проблема, очевидно, заклю-
чается в  высокой стоимости такого инстру-
мента при низкой коммерциализации. Тем 
не менее ряд экологических задач уже сейчас 
можно решать с применением недорогостоя-
щего оборудования и свободно распространя-
емого программного обеспечения.

Рис.  10. Пример таксономической идентификации зоопланктеров на  уровне рода или вида (Daphnia 
magna) по признакам, различимым на сканированных изображениях

Fig. 10. An example of taxonomic identification of zooplankers at the genus or species level (Daphnia magna) 
based on characteristics distinguishable on the scanned images
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Преимущество метода БИА по  сравне-
нию с  обычной микроскопией проявляется 
при обработке большого количества собран-
ных проб, в которых таксономический состав 
зоопланктеров уже известен либо не  слиш-
ком важен. Такие задачи могут возникать при 
изучении пространственного распределения 
и  временной динамики зоопланктона в  вод
ных экосистемах. Например, выявление су-
точной динамики (день, ночь) вертикально-
го распределения каляниды Arctodiaptomus 
salinus в оз. Шира в течение двух суток было 
основано на  25 количественных пробах зоо-
планктона (Dubovskaya et al., 2018). Для из-
учения макромасштабной гетерогенности 
зоопланктона в  оз. Женева потребовалось 
33 интегральных пробы зоопланктона, ото-
бранных в течение трех суток протягиванием 
планктонной сети с глубины 50 м до поверх-
ности (Pinel-Alloul et al., 1999). Традиционный 
метод обработки этих проб  – ​счет и  микро-
скопирование – ​достаточно трудоемок и вре-
мязатратен. Только стандартная обработка 
пробы счетным методом под бинокуляром 
обычно занимает 1,5–2 ч, определение видов 
(микроскопирование) и  заполнение таблицы 
на  ПК увеличивают полное время обработ-
ки до 3 и более часов. Однако в лаборатории 
отобранные стандартными методами пробы 
зоопланктона могут быть подвергнуты авто-
матической обработке пропусканием их че-
рез систему FlowCAM (например, Detmer et 
al., 2019) или Zooscan – ​сканированием пробы 
на сканере, соединенном с компьютером (на-
пример, Romagnan et al., 2016, настоящая рабо-
та). Сканирование планктонных проб позво-
ляет провести их автоматическую обработку 
для изучения не только морского зоопланкто-
на и морского снега (например, Benedetti et al., 
2019), но и частиц микропластика (Pedrotti et 
al., 2016). В нашем случае получен список ви-
дов/родов/более крупных таксонов зооплан-

ктона, их численность и биомасса в 20 озерах 
(см. приложение на сайте журнала). Такая оп-
тимизация обработки проб позволяет за мень-
шее время обработать большее количество 
образцов по  сравнению с  традиционными 
методами (Romagnan et al., 2016; Detmer et 
al., 2019). По нашим оценкам время обработ-
ки пробы вышеописанным методом БИА (1,5 
ч) на 25–50 % меньше, чем при классической 
обработке (2–3 ч), т. е. выигрыш во времени 
только одной пробы может составить 30 мин 
и более. Сканированные изображения не пор-
тятся со временем, и можно вернуться к ним 
повторно (Gorsky et al., 2010; Vandromme et al., 
2012). Кроме того, обработку можно прово-
дить дистанционно и распределять материал 
между несколькими исследователями.

Еще одна тенденция развития методов 
автоматизированного счета планктонных 
организмов  – ​конструирование приборов, 
способных проводить измерения непосред-
ственно в  водной толще. Среди ранних под-
водных аппаратов для изучения планкто-
на, очевидно, самым известным является 
непрерывный планктонный рекодер (The 
Continuous Plankton Recorder – ​CPR), исполь-
зуемый в  различных морских программах 
мониторинга (Warner, Hays, 1994). Его кон-
струкция не менялась с 1948 г. по сегодняш-
ний день, что дает возможность сравнивать 
все сделанные наблюдения с  помощью CPR 
между собой. Конечно, данное устройство 
не  оснащено никакими камерами и  просто 
собирает организмы планктона на движущу-
юся фильтрующую ленту, которая попадает 
в  отсек с  формалином. Дальнейший анализ 
собранного материала осуществляется под 
микроскопом, но  также может быть заснят 
на  цифровую камеру либо отсканирован. 
Позже идея подводного анализатора планкто-
на воплотилась в виде множества устройств, 
имеющих в  своем составе регистрирующие 
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фото- и видеоэлементы. Наиболее известны-
ми аппаратами счета планктонных организ-
мов признаны лазерный оптический счетчик 
высокого разрешения HR-LOPC (например, 
Kydd et al., 2018), подводный видеопрофайлер 
UVP (Picheral et al., 2010) и in situ ихтиоплан-
ктонная видеосистема ISIIS (Cowen, Guigand, 
2008). В пресных водах также имеется поло-
жительный опыт применения видеорегистра-
ции зоопланктона и  частиц in situ (Zadereev 
et al., 2010; Simoncelli et al., 2019). Очевидно, 
рутинная обработка проб зоопланктона под 
микроскопом будет постепенно заменяться 
автоматизированными методами анализа, 
при этом качество и доступность последних 
будет постоянно расти.

Заключение

Проведенная работа показала перспек-
тивность обработки сканированных стан-
дартных и  окрашенных проб зоопланктона 
методом БИА с  помощью свободно распро-
страняемого программного обеспечения 
imageJ/Fiji и ilastik. Создание промежуточных 
коллекций объектов для распознавания и сче-
та способствует более качественной обработ-
ке проб и уменьшает требования к мощности 

компьютера. Для зоопланктона континен-
тальных водоемов метод представляется осо-
бенно подходящим в связи с меньшим морфо-
логическим разнообразием континентального 
зоопланктона по  сравнению с  морским, так 
как первый состоит в  основном из  трех так-
сономических групп (коловратки, кладоцеры, 
копеподы), а морской – ​из  гораздо большего 
числа таксонов (включая личинки крабов 
и  раков, эвфаузиды, аппендикулярии, хетог-
наты, остракоды, птероподы и т. д.) и частиц 
морского снега разного размера и  содержа-
ния. Существенным преимуществом БИА 
по  сравнению со  стандартным счетным ме-
тодом является возможность обработки всей 
пробы, а не квоты, т. е. получение размерного 
распределения всех организмов исследуемо-
го вида в пробе, а не всего лишь порядка 100 
экземпляров, что практикуется для счетного 
метода. Так же могут быть просчитаны ча-
стицы искусственного происхождения, на-
пример микропластик. Это в  совокупности 
с  большим количеством отобранных проб 
дает наиболее достоверный результат для 
статистических оценок планктона в  водоеме 
и экономит время по сравнению со стандарт-
ным счетным методом.

Список литературы / References

Гладышев М. И. (1990) Суточная динамика вертикального распределения массовых ви-
дов зоопланктона в  Сыдинском заливе Красноярского водохранилища. Известия Сибирско-
го отделения Академии наук СССР. Серия биологических наук, 3: 78–85 [Gladyshev M. I. (1990) 
Daily dynamics of vertical distributions of mass zooplankton species in the Sydinskiy Bay of the 
Krasnoyarsk reservoir. Bulletin of the Siberian Branch of the USSR Academy of Sciences. Biological 
Science Series [Izvestiya Sibirskogo otdeleniya Akademii nauk SSSR. Seriya biologicheskih nauk], 3: 
78–85 (in Russian)]

Дубовская О. П. (2008) Оценка количества мертвых особей рачкового зоопланктона в во-
доеме с помощью окрашивания проб аналиновым голубым: методические аспекты примене-
ния. Журнал Сибирского федерального университета. Биология, 1(2): 145–161 [Dubovskaya O. P. 
(2008) Evaluation of abundance of dead crustacean zooplankton in a water body using staining of the 
samples by aniline blue technique: methodological aspects. Journal of Siberian Federal University. 
Biology, 1(2): 145–161 (in Russian)]



– 28 –

Olesya E. Yolgina, Alexander P. Tolomeev… Computer Processing and Analysis of Scanned Zooplankton Samples…

Кононова О. Н., Фефилова Е. Б. (2018) Методическое руководство по  определению 
размерно-весовых характеристик и организмов зоопланктона европейского севера Рос-
сии. Сыктывкар, Институт биологии Коми НЦ УрО РАН, 152 с. [Kononova O. N., Fefilova E. B. 
(2018) Methodological guideline for the determination of dimensional and weight characteristics of 
zooplankton organisms in the European North of Russia. Syktyvkar, Institute of Biology of Komi 
Science Centre of the Ural Branch of the Russian Academy of Sciences, 152 p. (in Russian)]

Алексеев В. Р., Цалолихин С. Я. (Ред.) (2010) Определитель зоопланктона и  зообенто-
са пресных вод Европейской России. Т.  1. Зоопланктон. М., Товарищество научных изданий 
КМК, 495 с. [Alekseev V. R., Tsalolikhin S. Ya. (Eds.) (2010) Key to identification of zooplankton and 
zoobenthos of fresh water of European Russia. Vol. 1. Zooplankton. Moscow, KMK Scientific Press, 
495 p. (in Russian)]

Abramoff M. D., Magalhaes P. J., Ram S. J. (2004) Image processing with ImageJ. Biophotonics 
International, 11(7): 36–41

Armengol  X., Miracle M. R. (2000) Diel vertical movements of zooplankton in lake La Cruz 
(Cuenca, Spain). Journal of Plankton Research, 22(9): 1683–1703

Benedetti F., Jalabert L., Sourisseau M., Becker B., Cailliau C., Desnos C., Elineau A., Irisson J.-
O., Lombard F., Picheral M., Stemmann L., Pouline P. (2019) The seasonal and inter-annual fluctuations 
of plankton abundance and community structure in a north atlantic marine protected area. Frontiers 
in Marine Science, 6: 214

Benfield M. C., Grosjean P., Culverhouse P. F., Irigoien  X., Sieracki M. E., Lopez-Urrutia A., 
Dam H. G., Hu Q., Davis C. S., Hansen A., Pilskaln C. H., Riseman E. M., Schultz H., Utgoff P. E., 
Gorsky G. (2007) RAPID: research on automated plankton identification. Oceanography, 20(2): 
172–187

Berg S., Kutra D., Kroeger T., Straehle C. N., Kausler B. X., Haubold C., Schiegg M., Ales J., 
Beier T., Rudy M., Eren K., Cervantes J. I., Xu B., Beuttenmueller F., Wolny A., Zhang C., Koethe 
U., Hamprecht F. A., Kreshuk A. (2019) ilastik: interactive machine learning for (bio)image analysis. 
Nature Methods, 16(12): 1226–1232

Bledzki L. A., Rybak J. I. (2016) Freshwater crustacean zooplankton of Europe: Cladocera & 
Copepoda (Calanoida, Cyclopoida). Key to species identification, with notes on ecology, distribution, 
methods and introduction to data analysis. Springer, 918 p.

Cowen R. K., Guigand C. M. (2008) In situ ichthyoplankton imaging system (ISIIS): system 
design and preliminary results. Limnology and Oceanography-Methods, 6: 126–132

Detmer T. M., Broadway K. J., Potter C. G., Collins S. F., Parkos  III J.J., Wahl D. H. (2019) 
Comparison of microscopy to a semi-automated method (FlowCAM®) for characterization of 
individual-, population-, and community-level measurements of zooplankton. Hydrobiologia, 838(1): 
99–110

Dubovskaya O. P., Tolomeev A. P., Kirillin G., Buseva Zh., Tang K. W., Gladyshev M. I. (2018) 
Effects of water column processes on the use of sediment traps to measure zooplankton non-predatory 
mortality: a mathematical and empirical assessment. Journal of Plankton Research, 40(1): 91–106

Gladyshev M. I., Dubovskaya O. P., Gubanov V. G., Makhutova O. N. (2003) Evaluation of non-
predatory mortality of two Daphnia species in a Siberian reservoir. Journal of Plankton Research, 
25(8): 999–1003



– 29 –

Olesya E. Yolgina, Alexander P. Tolomeev… Computer Processing and Analysis of Scanned Zooplankton Samples…

Gorsky G., Ohman M. D., Picheral M., Gasparini S., Stemmann L., Romagnan J.-B., Cawood A., 
Pesant S., Garcia-Comas C., Prejger F. (2010) Digital zooplankton image analysis using the ZooScan 
integrated system. Journal of Plankton Research, 32(3): 285–303

Grosjean P., Picheral M., Warembourg C., Gorsky G. (2004) Enumeration, measurement, and 
identification of net zooplankton samples the ZOOSCAN digital imaging system. ICES Journal of 
Marine Science, 61(4): 518–525

Jansen S. (2008) Copepods grazing on Coscinodiscus wailesii: a question of size? Helgoland 
Marine Research, 62(3): 251–255

Jouandet M.-P., Trull T. W., Guidi L., Picheral M., Ebersbach F., Stemmann L., Blain S. (2011) 
Optical imaging of mesopelagic particles indicates deep carbon flux beneath a natural iron-fertilized 
bloom in the Southern Ocean. Limnology and Oceanography, 56(3): 1130–1140

Kreshuk A., Kutra D. (2020) ilastik beyond pixel Classification. Webinar. URL: https://www.
youtube.com/watch?v=_ValtSLeAr0 (Accessed 05.12.2020)

Kydd J., Rajakaruna H., Briski E., Bailey S. (2018) Examination of a high resolution laser optical 
plankton counter and FlowCAM for measuring plankton concentration and size. Journal of Sea 
Research, 133: 2–10

Lombard F., Boss E., Waite A. M., Vogt M., Uitz J., Stemmann L., Sosik H. M., Schulz J., 
Romagnan J-B., Picheral M., Pearlman J., Ohman M. D., Niehoff B., Möller K. O., Miloslavich P., Lara-
Lpez A., Kudela R., Lopes R. M., Kiko R., Karp-Boss L., Jaffe J. S., Iversen M. H., Irisson J-O., Fennel 
K., Hauss H., Guidi L., Gorsky G., Giering S. L.C., Gaube P., Gallager S., Dubelaar G., Cowen R. K., 
Carlotti F., Briseño-Avena C., Berline L., Benoit-Bird K., Bax N., Batten S., Ayata S. D., Artigas L. F., 
Appeltans W. (2019) Globally consistent quantitative observations of planktonic ecosystems. Frontiers 
in Marine Science, 6: 196

Miura K., Sladoje N. (eds.) (2020) Bioimage data analysis workflows. Springer International 
Publishing, 170 p.

Rahlff J., Ribas-Ribas M., Brown S. M., Mustaffa N. I.H., Renz J., Peck M. A., Bird K., Cunliffe 
M., Melkonian K., Zappa C. J. (2018) Blue pigmentation of neustonic copepods benefits exploitation of 
a prey-rich niche at the air-sea boundary. Scientific Reports, 8: 11510

Pedrotti M. L., Petit S., Elineau A., Bruzaud S., Crebassa J-C., Dumontet B., Martí E., Gorsky G., 
Cózar A. (2016) Changes in the floating plastic pollution of the Mediterranean sea in relation to the 
distance to land. PLoS ONE, 11(8): e0161581

Picheral M., Elineau A. (2020) Zooscan manual to scan and process samples. Quantitative 
Imaging Platform of Villefranche sur Mer (PIQv). URL: https://drive.google.com/file/d/1jRJnKaD_
b0U‑qZYbye2pcrVA1_mhUzAP/view (Accessed 29.11.2020)

Picheral M., Guidi L., Stemmann L., Karl D. M., Iddaoud G., Gorsky G. (2010) The Underwater 
Vision Profiler 5: An advanced instrument for high spatial resolution studies of particle size spectra 
and zooplankton. Limnology and Oceanography-Methods, 8: 462–473

Pinel-Alloul B., Guay C., Angeli N., Legendre P., Dutilleul P., Balvay G., Gerdeaux D., Guillard 
J. (1999) Large-scale spatial heterogeneity of macrozooplankton in Lake of Geneva. Canadian Journal 
of Fisheries and Aquatic Sciences, 56(8): 1437–1451

Rebollo E., Bosch M. (Eds.) (2019) Computer optimized microscopy: methods and protocols. 
Book series «Methods in molecular biology», Volume 2040. Humana Press, 467 p.



Olesya E. Yolgina, Alexander P. Tolomeev… Computer Processing and Analysis of Scanned Zooplankton Samples…

Romagnan J. B., Aldamman L., Gasparini S., Nival P., Aubert A., Jamet J. L., Stemmann L. (2016) 
High frequency mesozooplankton monitoring: Can imaging systems and automated sample analysis 
help us describe and interpret changes in zooplankton community composition and size structure – ​An 
example from a coastal site. Journal of Marine Systems, 162: 18–28

Simoncelli S., Kirillin G., Tolomeev A. P., Grossart H.-P. (2019) A low-cost underwater particle 
tracking velocimetry system for measuring in situ particle flux and sedimentation rate in low-turbulence 
environments. Limnology and Oceanography-Methods, 17(12): 665–681

Vandromme P., Stemmann L., Garcìa-Comas C., Berline L., Sun X., Gorsky G. (2012) Assessing 
biases in computing size spectra of automatically classified zooplankton from imaging systems: A case 
study with the ZooScan integrated system. Methods in Oceanography, 1–2: 3–21

Warner A. J., Hays G. C. (1994) Sampling by the continuous plankton recorder survey. Progress 
in Oceanography, 34(2–3): 237–256

Zadereev E. S., Drobotov A. V., Tolomeev A. P., Anishchenko O. V., Yolgina O. E., Kolmakova 
A.A (2021) The effect of salinity and nutrient load on the ecosystems of selected lakes in the south of 
Siberia. Journal of Siberian Federal University. Biology, 14(2): 133–153

Zadereev E. S., Tolomeyev A. P., Drobotov A. V., Emeliyanova A. Yu., Gubanov M. V. (2010) The 
vertical distribution and abundance of Gammarus lacustris in the pelagic zone of the meromictic lakes 
Shira and Shunet (Khakassia, Russia). Aquatic Ecology, 44(3): 531–539

Zadereev E. S., Tolomeev A. P., Drobotov A. V. (2012) Asynchronous vertical migrations of 
zooplankton in stratified lakes. Contemporary Problems of Ecology, 5(4): 443–449


